
 

 

 

  

University of Alberta Computer Process Control Group 

Subspace Closed-loop 

Identification 
Limited Trial Version 

Written by: CPC Control Group, University of Alberta 

Version 2.0 

 



 

 

ii 

Table of Contents 
 

Introduction 1 

System Requirements 1 

Quick Start 1 

Detailed Instructions 6 

Theory 6 

Subspace Identification 6 

Subspace identification of a closed-loop system 8 

Data Storage 10 

Data Storage Format 10 

Data Generation 11 

Using the Toolbox 11 

Installation 11 

Starting the Toolbox 11 

In-depth Discussion of the Toolbox 13 

Example 1 19 

Example 2 22 

References 25 

 

  

 



 

 

iii 

 

List of Figures 
Figure 1: The first GUI that appears 1 

Figure 2: The main GUI 2 

Figure 3: Main GUI with the closed-loop data loaded 3 

Figure 4: The estimated state-space model and fit analysis 4 

Figure 5: Residue test results 5 

Figure 6: Step response model results 5 

Figure 7: Closed-loop system 9 

Figure 8: The first GUI that appears 12 

Figure 9: Data Information Window 14 

Figure 10: Data View and Selection Panel 15 

Figure 11: Run Panel 15 

Figure 12: Data Plot Axes 16 

Figure 13: Validation Panel 17 

Figure 14: Residual Test Window 18 

Figure 15: Estimated Step Response Coefficients 18 

Figure 16: Window for Entering the Continuous-Time Model Orders 19 

Figure 17: Estimated Continuous-Time Models 19 

Figure 18: Simulink Model for Collecting the Data 20 

Figure 19: Results of Using the Given Data 21 

Figure 20: Residual Test Results for Example 1 21 

Figure 21: Results of Closed-Loop Identification for Example 2 23 

Figure 22: Residual Test Results for Example 2 24 

 



1 

 

 

Introduction 
 The “Subspace Closed-loop Identification” toolbox was developed by the Computer 

Process Control Group at the University of Alberta to allow closed-loop identification to be 

performed in MATLAB using the subspace approach. 

 A “Quick Start” approach to using this algorithm is presented, along with a detailed 

section containing full explanations and examples for using this algorithm. 

System Requirements 
 In order to run this program properly, the following programmes are required: 

1) MATLAB 2006a (MATLAB 7.1) or better. It should be noted that the newest version of 

MATLAB (MATLAB 2008a) makes the toolbox run slower. 

2) The SYSTEM IDENTIFICATION TOOLBOX from MATLAB is required. 

Quick Start 
 For quickly using the toolbox, the following steps should be followed: 

1) Unzip the files to the desired location. 

2) Start MATLAB, and point the current directory to the location of the unzipped files. 

3) At the command prompt, type >>main_CLsysID to start the toolbox. The GUI shown 

in Figure 1 should appear. 

 

Figure 1: The first GUI that appears 
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Figure 2: The main GUI 

4) Press the Run button in the Start menu. A new GUI will appear that is shown in Figure 

2. 

5) This GUI tool provides closed-loop subspace identification using the joint-output 

identification method. 

6) You have to load a set of closed-loop experiment data in Compact format (to be 

explained shortly) using the Data submenu in the File menu. 
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7) For the purpose of this quick start, we will use the sample data provided from a MIMO 

example. 

8) When the data is loaded, the corresponding information about it can be obtained by 

pressing the Data Information button. After loading the data, the GUI should 

resemble Figure 3. 

 

Figure 3: Main GUI with the closed-loop data loaded 

9) Use the Run button to estimate the process model from closed-loop data. Depending on 

the type of process dynamics, the number of inputs and outputs, and the number of data 
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points, it may take between a few seconds to couple of minutes to obtain a model. The 

results of pressing this button are shown in Figure 4. 

 

Figure 4: The estimated state-space model and fit analysis 

10) The results of model validation are provided in the Validation panel including the 

prediction fit and residual test results. Further information about the residuals can be 

found by pressing the Residue test button. The results are shown in Figure 5. 

11) The estimated model can be refined using the prediction error method. You can use the 

Refine by PEM button in the Validation panel. 
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12) Direct step response estimation and continuous-time transfer function models between 

each input and output can also be obtained using the Step Resp. button in the Validation 

panel. The results are shown in Figure 6. 

 

Figure 5: Residue test results 

 

Figure 6: Step response model results 
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Detailed Instructions  

Theory 

Subspace identification methods provide an alternative approach to the classical system 

identification methods like the prediction error method (Ljung L. , 1999) and the instrument 

variable method (Söderström & Stoica, 1989). Subspace methods use efficient computational 

algorithms such as QR-factorization and singular value decomposition to compute the parameter 

values. This makes these methods numerically robust. Different subspace identification methods 

have been developed in the last two decades, including the regression analysis approach, N4SID 

(numerical subspace state space identification), MOESP (MIMO output error state space), CVA 

(canonical variate analysis) (Knudsen, 2001; Larimore, 1996; Moonena, De Moora, 

Vandenberghea, & Vandewalle, 1989; Van Overschee & De Moor, 1994; Van Overschee & De 

Moor, 1995; Verhaegena & Dewilde, 1992; De Moor & Van Overschee, 1996). As well, work 

has been devoted to implementing closed-loop, subspace system identification for control-

relevant identification and controller performance assessment. Many subspace methods have 

been extended to closed-loop identification (Knudsen, 2001; Ljung & McKelvey, 1996; 

Tangirala, Lakshminarayanan, & Shah, 1997; Van Overschee & De Moor, 1997; Kadali & 

Huang, 2002). An improved closed-loop subspace identification method was also presented in 

(Danesh Pour, Huang, & Shah, 2008) using the joint input-output identification approach. An 

alternative formulation of this method with guaranteed consistency is proposed in(Huang & 

Kadali, 2008). This programme is based on the last algorithm. 

Subspace Identification 

 Consider the following state space representation for a linear system with l inputs and m 

outputs: 

  

1t t t

t t t

t

t

x Ax Bu Ke
y Cx Du e

+ = + +⎧
⎨ = + +⎩

 (1) 

where xt ∈ Rn is the state, ut ∈ Rl is the input, yt ∈ Rm is the output, and et ∈ Rm is the white noise 

disturbance. System (1) can be rewritten in terms of the basic subspace equations for output and 

states, that is, 
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where p represents past values of the system, f represents future values of the system, Xf ∈ Rn×j is 

the subspace matrix of future states given by 

 ( )1, ,f N N N jX x x x+ += … 1−

⎟
⎟

 (3) 

ΓN ∈ RmN×n is the extended observability matrix defined as 

  (4) 
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 (5) 

Le ∈ RmN×mN
 is the extended error dynamics matrix defined as 
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0

e
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 (6) 

Δd
N ∈ Rn×lN is the transposed extended controllability matrix of (A, B) 

 ( )1 2, , , ,d N N
N A B A B AB B− −Δ = …  (7) 

Δs
N ∈ Rn×mN is the transposed extended controllability matrix of (A, K) 

 ( )1 2, , , ,s N N
N A K A K AK K− −Δ = …  (8) 

Up ∈ RnlN×j  is the data Hankel matrix for past inputs defined as 
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 (9) 

Uf ∈ RlN×j  is the data Hankel matrix for future inputs defined as 
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Yp ∈ RmN×j is the data Hankel matrix for past outputs defined similarly to Equation (9), 

Yf ∈ RmN×j is the data Hankel matrix for future outputs defined similarly to Equation (10), Ep ∈ 

RmN×j is the data Hankel matrix for past errors defined similarly to Equation (9), and Ef ∈ RmN×j is 

the data Hankel matrix for future errors defined similarly to Equation (10). 

 In open-loop subspace identification in order to reduce sensitivity to noise, j should be 

much larger than 

 ( )max ,mN lN  (11) 

In many ways, j plays the same role as the number of observations in classical identification. The 

number of rows in the data Hankel matrices, N, is related to the order of the system. 

 Using a regression analysis approach (Knudsen, 2001), it can be shown that 

  f w p u f e fY L W L U L E= + +  (12) 

 where Lw ∈ RmN×(l + m)N and Wp is defined as 

  p
p

p

Y
W

U
⎡ ⎤

= ⎢ ⎥
⎣ ⎦  

(13) 

This gives an input-output equation in the subspace framework. 

Subspace identification of a closed-loop system 

For the closed-loop system shown in Figure 7, two separate open-loop models can be 

defined: a model from the setpoint rt to the output yt and another model from rt to the controller 

output ut. Similarly to Equation (12), these two systems can be represented by the following 

input-output relationships (Huang & Kadali, 2008): 

 p
f Y YR f Y

p

Y
Y L L R L E

R
⎡ ⎤

= + +⎢ ⎥
⎣ ⎦

E f  (14) 
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where 
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Figure 7: Closed-loop system 

 If it is assumed that Rf  is uncorrelated with Ef, and WU
p with WY

p, each of the open-loop 

problems can be solved using the least square method. In (Huang & Kadali, 2008), it has been 

shown that the open-loop subspace matrices Lu, Le, and ΓN, and the input noise covariance matrix 

can be estimated from the closed-loop subspace matrices, LYR, LUR, and LUE, using a joint input-

output framework. The state-space matrices can be obtained as follows: 
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 (17) 

where + represents the Penrose pseudo-inverse, ◌̂ represents an estimated value, Pv is the noise 

covariance matrix, and R is the parameter covariance matrix.  

 The Lu and Le matrices as defined by Equations (5) and (6) contain the impulse response 

coefficients (Markov parameters) of the process. Therefore, the step response coefficients 

between each input and output can be directly extracted from these subspace matrices without 

 
+

C G
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requiring an explicit process model. In fact, this approach provides more reliable estimation of 

the step response, especially when the final model is not accurate. In this toolbox, nonlinear 

regression is used to fit a continuous-time transfer function model to each set of step response 

coefficients. Both the first-order plus time delay (FOPTD) and second-order plus time delay 

(SOPTD) models are fitted to each set and the model with the better fit is selected. 

Data Storage 

Data Storage Format 

 The data storage format is called a compact format. Assume that there are j samples of 

output, input, and setpoint data with a total of m control variables and l manipulated variables 

with a total of q tags. In the compact data storage method, the data is stored as an object 

containing the following entries: 

1) controller_Status: This is a j-by-1 double matrix that contains the status of each of the 

controllers, where 1 represents a controller that is “on” and 0 represents a controller that 

is “off.” 

2) cell_char_TagList: This is a q-by-1 cell matrix that contains the name of each of the tags 

that are presented in the process. 

3) cell_char_TimeStamp: This is a j-by-1 cell matrix that contains the time stamp for each 

of the samples. 

4) dbl_Compact_Data: This is a j-by-(2m+l) double matrix that contains the values for 

each of the outputs, inputs and setpoints at sample periods. 

5) dbl_SamplingTime: This is a scalar double that contains the sampling time for the data. 

6) int_CVNumber: This is a scalar integer that contains the number of controlled variables 

in the process, that is, m. 

7) int_MVNumber: This is a scalar integer that contains the number of manipulated 

variables in the process, that is, l. 

8) status: This is a j-by-(l + m) double matrix that stores the data in the following manner: 

The first t columns contain the status of the controller variables, while the remaining s 

columns contain the status of the manipulated variables. A value of 1 signifies that the 

data is good. 
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Data Generation 

The data storage file can be generated using gen_cmpct_data.p. A set of closed-loop experiment 

data (identification data) should be present in the MATLAB workspace. If your data is ready in 

the workspace, run the code. The followings will appear in the command window: 

***************************************************************** 
Consider a process with m inputs and p outputs: 
The following information should be available in WORKSPACE: 
  
 1. CL Excitation data; Output, Input and Setpoint data (y,u,r) 
 2. Sampling time   
***************************************************************** 
Press ENTER to continue or type X to exit :   

Press enter to continue if the data has already been created; otherwise quit the programme, create 

the data, and try again. Once enter is pressed, the following will appear: 

Provide Closed-loop excitation data matrix [y u r]:  

The data should be arranged in the given order, that is, output, input, and setpoint. Next, the 

number of process outputs must be entered: 

number of outputs: 

Then, the sampling time will be entered: 

Sampling time:  

Finally, the name of the file to which the data should be saved is entered at the prompt:  

The file name to save compact data (e.g. test_cmpct_data): 

 This programme will create a “.mat” file that is saved to the current path in MATLAB. 

Using the Toolbox 

Installation 

 The toolbox can be installed by simply unzipping the files to any desired location. In 

order for the toolbox to function properly, the System Identification Toolbox should be installed. 

Starting the Toolbox 

The toolbox can be accessed from MATLAB using the following sequence of commands. 
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First MATLAB itself should be started from the directory pointing to the folder containing the 

files for this toolbox. Next, at the command prompt, type >> main_CLsysID. The GUI shown in  

should appear. This GUI is the main access to the toolbox. To start a session of the toolbox, click 

on the Run submenu in the Start menu. This will bring up a new GUI, which is shown in Figure 

9. Each of the main parts of the GUI in Figure 9 will be discussed separately later. 

 

Figure 8: The first GUI that appears 

 



13 

 

 

 
Figure 9: The main GUI for this toolbox 

In-depth Discussion of the Toolbox 

Section 1: Main Menu 

 The Main Menu consists of the following areas: 

 
Figure 10: The “File” menu 
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1) Data: Clicking this menu will allow the user to load the closed-loop experiment data for 

analysis. 

2) New: Clicking this menu will clear all the data from the current GUI and allow the user 

to restart the analysis from a clean layout. 

3) Save: Clicking this menu will allow the user to save the resulted state space model or step 

response coefficients on the disk.  

4) Save as: Clicking this menu will allow the user to re-save the resulted state space model or 

step response coefficients. 

 
Figure 11: The “Save” menu 

Section 2: Data Information Button 

 This button opens a new window which shows information about the loaded experiment 

data including the data file name, the number of controller variables (CV), the number of 

manipulated variables (MV), the sampling time, the starting time, and end time. A sample 

example of the data provided is shown in Figure 9. 

 

Figure 9: Data Information Window 

Section 3: Data View and Selection Panels 

 The data view and selection panels are shown in Figure 10. 
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Figure 10: Data View and Selection Panel 

 The following are the most important sections: 

1) Data view: This pane enables you to choose the controlled variable (CV), manipulated 

variable (MV), or setpoint variable (SP) which you want to be shown on the 

corresponding axes. 

2) Data selection: In this filed, you can specify which data sections are to be used for 

identification (est. data) and validation (val. data). The end value for each selection must 

be greater than its starting value. In order to register the values, click the select button. 

Section 4: Run Panel 

 A close-up view of the run panel is shown in Figure 11.  

 

Figure 11: Run Panel 

1) Run: This button is used to run the main closed-loop identification algorithm. The button 

is disabled until the data is loaded. 

2) Prediction Horizon (N) Panel: The slider can be used to set the appropriate values for 

the prediction horizon, N. The range of values selected is determined by the algorithm on 
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first run. From then on, the user is able to select the appropriate value. In order to enable, 

manual selection, the radio button beside auto should be ticked off; otherwise an 

automatically selected value will be used.  

Section 5: Plot Data 

Three axes, as shown in Figure 12, are used to display the controlled variables, 

manipulated variables, and setpoint data. Since only a single variable of each type can be 

displayed at a time, the selections are made in the data selection panel (see Section 3: Data View 

and Selection Panels). 

Section 6: Validation Panel 

In this panel, model validation and residual test results are presented. A close-up of this 

section is shown in Figure 13. As well, in this panel the model order can be changed and the step 

response functions determined. The main parts of this panel are: 

1) Model Order Subpanel: The estimated order for the state space model is shown in this 

subpanel. If the Set option is enabled, then the model order can be changed manually. 

When the new order is entered, press the Change button to rerun the model estimation 

algorithm to display the new results. 

 

Figure 12: Data Plot Axes 
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Figure 13: Validation Panel 

2) Validation Data Plot: This plot shows the validation data as well as the model prediction. 

Only one pair of data points can be shown at a single time, so the user has to choose 

which output is to be displayed using the CV drop-down box located at the top of the 

panel. The prediction horizon can be changed using the Pred. hor. textbox. The default 

value for the prediction horizon is 15 samples. 

3) Prediction Fit for Each CV Plot: This plot shows the results of comparing the 

validation output to the model prediction for each process output. Each bar represents the 

percent fit for one controller variable. 

The three push buttons, located on the left of this panel, are called as follows:  

1) Refine by PEM: This button will run the pem function from MATLAB’s system 

identification toolbox to refine the identified model obtained subspace identification. It 

should be noted that this need not produce a better model. If the new model is not better, 

then the previously estimated subspace model can be restored by pressing the Change 

button. 

2) Residue Test: This button can be used to view the results of residue tests on the last 

estimated model. Only the cross-correlation test is performed, so the disturbance model is 

not tested. The results are shown in Figure 14. 
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Figure 14: Residual Test Window 

3) Step Resp.: This button will open a new window that allows the user to estimate the step 

response coefficients directly from the subspace matrices. This is shown in Figure 15. 

The Export menu is used to save the step response coefficients. The "Cont. Model" 

menu is used to obtain the continuous-time models (FOPTD or SOPTD) for the estimated 

step response coefficients. A window as shown in Figure 19 will be opened to enter the 

model orders for each step response. The nonlinear regression algorithm from 

MATLAB’s statistics toolbox is used to fit a continuous-time model to each step 

response. The results will be shown in a new window, similar to that shown in Figure 17. 

Note that the results of this calculation may not be reliable. 

 

 

Figure 15: Estimated Step Response Coefficients 
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Figure 16: Window for Entering the Continuous-Time Model Orders 

 

Figure 17: Estimated Continuous-Time Models 

Example 1 

 A set of closed-loop identification data generated from the following system is provided 

with the toolbox in a file called SISO_IdData_CL.mat: 

 

( )

1

0.6 0.6 0 1.6161 1.1472
0.6 0.6 0 0.3481 1.5204
0 0 0.7 2.6319 3.1993

0.4373 0.5046 0.0936 0.7759

t t t

t t

x x u

y x

+

−⎛ ⎞ ⎛ ⎞ ⎛
⎜ ⎟ ⎜ ⎟ ⎜= − + − + −⎜ ⎟ ⎜ ⎟ ⎜
⎜ ⎟ ⎜ ⎟ ⎜ −⎝ ⎠ ⎝ ⎠ ⎝

= − − − +

e

u e

⎞
⎟
⎟
⎟
⎠

 (18) 

A continuous-time proportional-integral (PI) controller, 

 0.050.1tu
s

⎛= +⎜
⎝ ⎠

ty⎞⎟  (19) 

is used to control the process. The Simulink diagram shown in Figure 18 can be used to collect 

the data. The identification test signal, r(t), is created using MATLAB’s idinput command 
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r=idinput(1000,'rbs',[0,0.06], [-1,1]); 

 

Figure 18: Simulink Model for Collecting the Data 

The idmodel block needs a variable called sys to be defined in the workspace. This can be done 

as follows: 

A=[0.6 0.6 0;-0.6 0.6 0;0 0 0.7]; 
B=[1.6161; -0.3481; 2.6319]; 
C=[-0.4373 -0.5046 0.0936]; 
Du=-0.7759; 
K=[-1.1472; -1.5204; -3.1993]; 
sys=idss(A,B,C,D,K,[0;0;0],1); 
sys.NoiseVariance=0.01; 

In the block parameters of idmodel, there is an option called “Add noise” which must be selected. 

Once the required variables have been defined in the workspace and the Simulink file has been 

run to obtain the simulated data, run gen_cmpct_data.p to create and save the data file using the 

Compact format. The data file is called  SISO_IdData_CL. Loading this data file into GUI, the 

state space model and continuous-time transfer function model of this process can be estimated. 

Click the run button to obtain the model estimates. The GUI should look similar to that shown 

in Figure 19. 
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Figure 19: Results of Using the Given Data 

 The residual values are shown in Figure 20. 

 

Figure 20: Residual Test Results for Example 1 
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Example 2 

 A MIMO example is also provided with the toolbox. The process to be controlled has two 

inputs and two outputs with transfer functions: 

  

 

1 2

1 1

1 2

1 1

1

1 1

1

1 1

0.5
1 0.4 1 0.1

0.3
1 0.4 1 0.8

1 0.6
1 0.5 1 0.5

0.5 1
1 0.5 1 0.5

p

l

z z
z zG

z z
z

z
z zG

z
z z

− −

− −

− −

− −

−

− −

−

− −

⎛ ⎞
⎜ ⎟− −⎜ ⎟=
⎜ ⎟
⎜ ⎟− −⎝
⎛ ⎞−
⎜ ⎟− −⎜ ⎟=
⎜ ⎟
⎜ ⎟
− −⎝ ⎠

z ⎠  (20) 

The controller transfer function is given as 

 

1

1

1

1 1

0.5 0.2 0
1 0.5

0.25 0.20
(1 0.5 )(1 0.5 )

c

z
zG

z
z z

−

−

−

− −

⎛ ⎞−
⎜ ⎟−⎜=
⎜ ⎟−
⎜ ⎟− +⎝ ⎠

⎟  (21) 

The required closed-loop data can be generated using the following commands: 

Gp=tf({[1],[4];[0.3],[1]},{[0 1 -.4],[1 -0.1 0];[ 0 1 -0.1],[1 -0.8 0]},1); 
Gl=tf({[1 0],[-.6];[0.5],[1 0]},{[1 -.5],[1 -.5];[1 -.5],[1 -.5]},1); 
Gc=tf({[.5 -.2],[0];[0],[.25 -.2 0]},{[1 -.5],[1];[1],[1 0 -.25]},1); 
r1=idinput(1000,'rbs',[0,0.03], [-5,5]); 
r2=idinput(1000,'rbs',[0,0.03], [-5,5]); 
r = [r1 r2]; 
t=[1:1000]'; 
[A,B,C,D,K] = tf2ssGpGl(Gp,Gl); 
% controller 
cont=idss(Gc);  
Ac = cont.a; Bc = cont.b; Cc = cont.c; Dc = cont.d;  
seeds = [1 2]; 

where tf2ssGpGl is a user-specified function given as 

function [A,B,C,D,K] = tf2ssGpGl(Gp,Gl) 
    ny = size(Gp.OutputDelay,1); 
    nu = size(Gp.InputDelay,1); 
    NUMGt={Gp.num Gl.num}; 
    DENGt={Gp.den Gl.den}; 
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    Gt = tf([NUMGt{1,1} NUMGt{1,2}] ,[DENGt{1,1} DENGt{1,2}] ,1); 
    set(Gt,'InputGroup',struct('Noise',[nu+1:nu+ny])) 
    model = idss(Gt); 
    A = model.a; B = model.b; C = model.c; 
    D = model.d; K = model.k; 
end 

A similar Simulink model to that used in Example 1 can be used to generate the data. After 

saving the simulated data using the compact format, loading it into the GUI, and pressing the run 

button, the results similar to that shown in Figure 21 should appear. The residual test results are 

shown in Figure 22. 

 

Figure 21: Results of Closed-Loop Identification for Example 2 
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Figure 22: Residual Test Results for Example 2  
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